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AKVIS NOISE BUSTER AI 13.0 | DIGITAL NOISE REDUCTION

No More Noise on Your Pictures!

AKVIS Noise Buster AI efficiently removes digital noise and grain from your photos using trained neural networks. The
program eliminates all types of noise without blurring images. Create professional quality photos!

Digital cameras opened the door to easy and entertaining photography. However, consumer digital cameras also have their
drawbacks: they often produce the so-called digital noise. It can be seen as artifacts or grains that compromise the
smoothness of the photo.

It is especially annoying on the skin as it makes it uneven. This kind of noise is called luminance noise. There can also be
chroma (color) noise which is perceived as random red and blue pixels, spoiling the color accuracy of the shot.

Digital noise can be produced by many factors: heating of the camera sensor, long exposure shooting, small pixel size
(therefore digital compact cameras generate much noisier images than digital SLRs), high ISO settings, etc.

AKVIS Noise Buster AI is efficient noise suppression software. It reduces both luminance and color noise on digital images
without spoiling other aspects of the photo.
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AI-Powered Digital Noise Reduction

The software uses neural networks to get rid of digital noise and improve the image. The program includes three modes:
Weak Noise, Strong Noise, and Strong Compression with Noise. Depending on the selected mode, the program uses the
appropriate neural network.

With AKVIS Noise Buster AI, your photos look neat and accomplished!
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The program is equally useful both for professional and home users. You don't need any special skills or knowledge to produce
high-quality results. Just select the appropriate mode.

Fix your grainy photos with a click!

Image Adjustments

You can also enhance the result obtained by AI using the Edge Intensity and Sharpness parameters. Tweak the settings
and observe the changes in real-time in the quick preview.
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Photo Editing Tools

In addition, you can also use manual photo editing tools in the toolbar: starting from cropping the image and ending with the
post-processing tools. For example, the History Brush allows you to mix the result and the original photo on selected areas.
The advanced Smart Blur tool (Home Deluxe/Business) smooths out grain and noise while preserving outlines and fine details.

Refine the result with a few clicks!
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Batch Processing

The software offers support for the Batch Processing feature that lets you automatically convert a series of images. It is
useful when dealing with a series of photos taken under the same conditions with identical camera settings. It saves you time
and effort.
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AKVIS Noise Buster AI is available in two editions: as a standalone application and as a plugin to a photo editor: AliveColors,
Adobe Photoshop, Adobe Photoshop Elements, Corel PaintShop Pro, etc.
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INSTALLATION ON WINDOWS

Please find instructions below on how to install the AKVIS programs on Windows.

You must have administrator rights to install the program on your computer.

Before installing the AKVIS plugins, please make sure that the image editor where you want to install the plugins, is closed. Or
re-run the image editor after the installation of the plugin.

 

1. Run the setup exe file.
2. Select your language and press the Install button.
3. To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

4. To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

5. Press the Install button.
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6. The installation is in progress.

7. The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-
mail address and confirm that you accept the Privacy Policy.
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8. Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the desktop,
if during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For example in
Photoshop: Filter -> AKVIS –> Noise Buster AI, in AliveColors: Effects -> AKVIS –> Noise Buster AI.
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INSTALLATION ON MAC

Follow the instructions to install the AKVIS software on a Mac computer.

You must have administrator rights to install the program on your computer.

 

1. Open the dmg file:

- akvis-noise-buster-app.dmg to install the Standalone version

- akvis-noise-buster-plugin.dmg to install the Plugin into your image editor.

2. Read the License Agreement and press Agree, if you agree with the conditions.

3. Finder will open with AKVIS Noise Buster AI application or AKVIS Noise Buster AI PlugIn inside.

 

4. To install the Standalone version, drag the AKVIS Noise Buster AI app into the folder Applications (or any other
place you like).

To install the Plugin, drag the entire AKVIS Noise Buster AI PlugIn folder into the Plug-Ins folder of your graphic
editor:

AliveColors: You can choose in the program's Preferences the folder of the plugins.

Adobe Photoshop: Library/Application Support/Adobe/Plug-Ins/CC 
(except CS6 version: Applications/Adobe Photoshop CS6/Plug-ins)
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After installation of the plugin, you will see a new item in the filters/effects menu of your photo editor. 
Select in Photoshop: Filter -> AKVIS -> Noise Buster AI, in AliveColors: Effects -> AKVIS -> Noise Buster AI.

Run the standalone application by double-clicking on its icon in Finder.

You can also run the AKVIS programs from the Photos app by choosing the Image -> Edit With command (in High Sierra and
later versions of macOS).
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INSTALLATION ON LINUX

Note: The AKVIS programs are compatible with Linux kernel 5.0+ 64-bit. You can find out the kernel version using the
uname -srm command.

 

Follow the instructions to install the AKVIS software on a Linux computer.

 

Installation on Debian-based systems:

Note: You need apt-install or apt-get permissions required to install software.

1. Run the terminal.
2. Create a directory to store keys:

sudo mkdir -p /usr/share/keyrings 

3. Download the key that signed the repository:

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 

or

wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 

4. Add the repository to the list where the system looks for packages to install:

echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-deb.sfo2.cdn.digitaloceanspaces.com
akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list 

5. Update the list of known packages:

sudo apt-get update 

6. Install AKVIS Noise Buster AI

sudo apt-get install akvis-noise-buster 

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates, use the command:

sudo apt-get upgrade 

To remove the program:

sudo apt-get remove akvis-noise-buster --autoremove 

 

Installation on RPM-based systems (CentOS, RHEL, Fedora):

1. Run the terminal.
2. Register the key that signed the repository:

sudo rpm --import https://akvis.com/akvis.asc 

3. Add the repository to the system:

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo 

4. Update the package list:

when using the dnf package manager:

sudo dnf update 

when using the yum package manager:

sudo yum update 

5. Install AKVIS Noise Buster AI:
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when using the dnf package manager:

sudo dnf install akvis-noise-buster 

when using the yum package manager:

sudo yum install akvis-noise-buster 

6. The installation is completed.

Launch the program via the terminal or using the program shortcut.

7. For automatic updates:

when using the dnf package manager:

sudo dnf upgrade 

when using the yum package manager:

sudo yum upgrade 

8. To remove the program:

when using the dnf package manager:

sudo dnf remove akvis-noise-buster 

when using the yum package manager:

sudo yum remove akvis-noise-buster 

 

Installation on openSUSE.

1. Run the terminal.
2. Login as a root user.
3. Add the key that signed the repository:

rpm --import http://akvis.com/akvis.asc 

4. Add the repository to the system:

zypper ar -r https://akvis.com/akvis.repo akvis 

5. Update the package list:

zypper ref 

6. Install AKVIS Noise Buster AI:

zypper install akvis-noise-buster 

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates:

zypper update 

To remove the program:

zypper remove akvis-noise-buster 

 

Installation using Flatpak:

1. Run the terminal.
2. Add the Flathub repository

sudo flatpak remote-add --if-not-exists flathub https://flathub.org/repo/flathub.flatpakrepo 

3. Add the AKVIS repository
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sudo flatpak remote-add --if-not-exists akvis --from https://akvis-
flatpak.sfo3.cdn.digitaloceanspaces.com/com.akvis.flatpakrepo 

4. Install AKVIS Noise Buster AI:

sudo flatpak install -y akvis com.akvis.akvis-noise-buster 

5. The installation is completed.

Launch the program using the program shortcut or the terminal:

flatpak run com.akvis.akvis-noise-buster 

6. To update all installed flatpaks, use the command:

sudo flatpak update -y 

to remove the program:

sudo flatpak remove -y com.akvis.akvis-noise-buster 

 

In order to display the program interface correctly, it is recommended to install the Compton or Picom composite manager.
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AKVIS SOFTWARE ACTIVATION

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS Noise Buster AI and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the
number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation
time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types:
Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available
in the program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet,
for example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (Noise-Buster.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS folder in
Users’ Shared (Public) Documents:

Windows:

C:\Users\Public\Documents\AKVIS

(This PC > Local Disk (C:) > Users > Public > Documents > AKVIS)

Mac:

/Users/Shared/AKVIS

Open the Finder,  se l ec t  the  Go menu,  then se lec t  Go to Folder... (⌘ +Shift+G ) ,  t ype

"/Users/Shared/AKVIS", and click Go.

Linux:

/var/lib/AKVIS

Your registration is completed!
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When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example, change Home
to Home Deluxe or Business).
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WORKSPACE

AKVIS Noise Buster AI can work independently as a standalone program as well as a plug-in to a photo editor.

Standalone is an independent program. You can run it in the usual way.

Plugin is an add-on for graphics editors, for example for Photoshop, AliveColors, and other compatible programs. To call
the plugin, select it from filters of your image editing program.

The AKVIS Noise Buster AI workspace looks like this:

 

Features of the Workspace:

Most of the AKVIS Noise Buster AI workspace is taken by the Image Window with two tabs: Before and After. In the
Before tab, the original image is shown, while in the After tab you can see the result. You can compare the original image
with the result by clicking any point of the image.

Note that when the After tab is pressed, it starts image processing with the current settings.

You can select how Image Window and Before/After tabs will be shown by adjusting the View Modes in the bottom part
of the left panel.

In the upper part of the window, you can see the Control Panel.

The button  opens the home page of AKVIS Noise Buster AI.

The button  (only in the standalone version) allows opening an image for processing.

Right-click this button to display the list of recent files. You can change the number of recent documents in the
program's Preferences.

The button  (only in the standalone version) allows saving a resulting image to the disk.
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The button  (only in the standalone version) allows printing the image.

The button  (only in the standalone version) opens the Batch Processing dialog to automatically process a series

of images.

The button  cancels the last action. If it is pressed multiple times, it will cancel several previous actions. This can

also be activated with the keyboard, by pressing Ctrl+Z  on Windows, ⌘ +Z  on Mac.

The button  restores an action cancelled by .

The button  launches filtration of the entire image. Before you press this button the filtration result is shown only in

the preview area.

The button  (only in the plugin version) allows applying the filtration result to the image and closes the AKVIS

Noise Buster AI window.

The button  shows information about the program: version, license, etc.

The button  is designed to call the Help files of the program.

The button  calls the Preferences dialog box for changing the program's options.

The button  opens a window showing the latest news about Noise Buster AI.

 

To the left of the main window there is the Toolbar. The tools' parameters are shown in a pop-up box after right-clicking in
the image.

Pre-Processing Tools (in the Before tab):

The button  switches on/off the Quick Preview area (more about the preview).

The button  (only in the standalone version) activates the Crop tool which allows cutting off unwanted areas in the

image.

Post-Processing Tools (available in the After tab):

Attention! If you switch to the Before tab and re-run the image processing , the changes made with these tools will be

lost!

The button  activates the Smudge tool which helps to refine the image by removing unwanted irregularities.

The button  activates the History Brush tool which restores areas to their original state.

The button  activates the Smart Blur tool which smooths out grain and noise while preserving outlines and details.

It is available only under Home Deluxe and Business licenses.

The tools' parameters:

- Size affects the tool's diameter. 
-  Hardness changes the blurriness of the edges of the tool. The lower the value, the more blurry the tool's edges
are. 
- Strength affects the force of the tool applied to the image.

Additional Tools:

The button  activates the Hand tool, which allows you to scroll the image when it does not fit within the Image

Window at the desired scale. To use it, click the button, bring the cursor over the image, and while keeping the left
mouse button pressed move in the desired direction.

Double-clicking the tool's icon  in the Toolbar makes the image fit the Image Window.

The button  activates the Zoom tool, which changes the image's scale. To zoom in, left click in the image. To zoom

out, right click in the image. Press Z  to quickly access the tool.

Double-clicking the tool's icon  in the Toolbar makes the image scale to 100% (actual size).

 

Moving and scaling the image is done in the Navigator. In the Navigator, you can see the reduced copy of the image. A
frame surrounds the part of the image visible in the Image Window; the area outside of the frame will be shaded. The frame
can be dragged to display a different part of the image. To move the frame, bring the cursor inside the frame, press the left
mouse button, and while keeping it pressed, drag the cursor.
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Additionally, you can move the image in the Image Window with the scroll bars or by holding down the space bar, then
holding down the left mouse button while moving the mouse. Use the scroll wheel of the mouse to move the image up/down,
by keeping the Ctrl  (⌘  in Mac) key pressed – to the left/to the right, by keeping the Alt  (Option  in Mac) key pressed −
scale the image. Right-click the scroll bar to activate the quick navigation menu.

Use the slider to scale the image in the main window. When you move the slider to the right, the image scale increases. When
you move the slider to the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field. Frequently used scale coefficients can
be found in a fall-down menu.

You can use hot-keys to change the image scale +  and Ctrl++  on Windows, ⌘ ++  on Mac to scale up the image, and -

and Ctrl+-  on Windows, ⌘ +-  on Mac to scale down the image.

 

Under the Navigator, in the Settings Panel, you can choose a preset in the Presets field and adjust the noise reduction
parameters.

Under the settings, you can see Hints for the parameters and buttons when you hover over them with the cursor. You can
choose where the hints will be shown or hide them in the Preferences.
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IMAGE VIEW MODES: BEFORE AND AFTER

At the bottom of the Toolbar of AKVIS Noise Buster AI, there are three buttons which let you choose how the Image
Window will look like and arrange the Before and After tabs.

Click the first button to open a submenu that contains various options for viewing the original and processed images:

- The button  provides the standard image window mode with two tabs: Before and After.

- The buttons  and  divide the main window into two parts, vertically or horizontally, respectively. The

original and processed images become partially visible and the tabs are combined to form the whole picture.

With this arrangement, it's possible to drag the splitter changing the aspect ratio between the Before and After
parts.

- The buttons  and  split the main window into two parts, vertically or horizontally, as well. However, in

contrast to the previous option, the windows display the same fragment of the image before and after processing.

Note: Use two windows side by side when you want to see and compare the original and processed versions of an
image fragment on one screen. If you would rather see the final image as a whole, you can choose the standard image
view mode.

The button  swaps the positions of the original image and result when displaying two windows.
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The 3rd button lets you choose the background color of the Image Window. Pressing , , or  changes the

background color to white, gray, or black, while clicking on  opens the Select Color dialog where you can choose a

color of your choice.
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HOW TO USE THE PROGRAM

AKVIS Noise Buster AI reduces both luminance and color noise on images without spoiling other aspects of the photo. The
software can work independently as a standalone program and as a plugin to a photo editor.

Follow the instructions below to reduce noise on a picture using AKVIS Noise Buster AI.

Step 1. Open an image.

- If you work with the standalone edition:

The dialog box Select File to Open appears if you double-click in the empty workspace of the program or if you

click  on the Control Panel. You can also drag the required image into the workspace of the program. The

program supports images in the JPEG, TIFF, BMP, PNG, WEBP, TGA, and RAW formats (CRW, NEF, ORF, PEF, etc.
- See the full list here). You can also drag the required image into the workspace of the program.

- If you work with the plugin:

Open an image in your photo editor by calling the command File -> Open or using the Ctrl+O  key combination

(or ⌘ +O  on Mac).

Call the AKVIS Noise Buster AI plugin in the Filter/Effects menu of the photo editor:

in AliveColors: Effects -> AKVIS -> Noise Buster AI; 
in Adobe Photoshop: Filter –> AKVIS –> Noise Buster AI; 
in Corel PaintShop Pro: Effects –> Plugins -> AKVIS –> Noise Buster AI; 
in Corel Photo-Paint: Effects –> AKVIS –> Noise Buster AI.

Step 2. You can start with processing the image using the default settings.

The result will be shown in the Quick Preview area in the Before tab. It is represented by a dotted frame. You can
drag the frame or draw it anew on any part of the image, thus analyzing parts of the photo.
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You can compare the filtered result with the original image by clicking in the preview area.

It's possible to change the size of the quick preview area in the program's Preferences .

Step 3. You can adjust the noise reduction parameters to achieve the best result.

The task of noise reduction is to find the golden mean between suppressing noise and keeping detail. Besides, it is
important to take into account the psychological characteristics of visual perception: when comparing the original and
the filtered photo pay your attention not only to details but to the overall impression as well. A certain amount of noise
does not necessarily spoil a picture, while some smoothness of a photo may add to the visual effect (especially in
portrait retouching where it is not desirable to see the skin structure in detail).

Step 4. To process the entire image, click  or press the After tab.

After processing, it is possible to switch between Before/After tabs by pressing the left mouse button anywhere in the
image window.
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Step 5. You can also use the post-processing tools in the After tab: Smudge , History Brush , and Smart

Blur .

Attention! If you change the parameters and re-run the image processing, the changes made with these tools will be
lost.

The Smudge tool  helps to refine the image by removing unwanted irregularities.

The History Brush tool  restores areas to their original state.

The Smart Blur tool  smooths out grain and noise while preserving outlines and fine details. It is available only

under Home Deluxe and Business licenses.
Step 6. It is possible to save the settings you like as a preset and use them in the future. The presets are also helpful
when working in the batch processing mode.

To save a preset, enter its name into the Presets field and press the Save button. If you change the values of the
parameters, you can always come back to the default settings of the preset by pressing the Reset button.

To delete a preset, select it from the list and press Delete.

To process an image with the settings of a certain preset, select it from the drop-down menu and click .

Step 7. In the standalone version, you can also print your image with .

Step 8. Save the processed image.

- If you work with the standalone edition:

Click the button  to open the Save As dialog box. Enter a name for the file, choose the format (TIFF, BMP,

JPEG, WEBP, TGA or PNG), and indicate the target folder.

- If you work with the plugin:

Click  to apply the result to the image and close the plugin's window.

In the image editor, call the Save As dialog box using the command File -> Save As, enter a name for the file,
choose the format, and indicate the target folder.

click to open a larger copy
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Original Noisy Photo

 
Weak Noise Mode

 
Strong Noise Mode

NOISE REDUCTION WITH AI

AKVIS Noise Buster AI uses specially trained neural networks to eliminate digital noise from photos.

Noise Removal

Noise on a color picture can be divided into luminance noise and color noise. Luminance noise is perceived as dark dots or
small blots, color noise represents color spots on areas having a different color. Another name for color noise is chroma noise.
The program removes both luminance and color noise, as well as jpeg compression artifacts.

 

Adjust the parameters in the Settings Panel.

Noise Level. The program uses neural networks to remove digital noise and enhance images. Select the noise suppression
mode that suits your photo best:

Weak Noise; 
Strong Noise; 
Strong Compression with Noise.
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Edge Intensity = 0

 
Edge Intensity = 100

 
Sharpness = 0

 
Sharpness = 100

 

Post-Processing

After removing noise, you may need to add sharpness and increase the clarity of edges.

Edge Intensity (0-100). The parameter makes the edges more clear and well-defined.

Sharpness (0-100). This parameter changes the clarity of the image by enhancing the contrast between pixels.
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BATCH PROCESSING

AKVIS Noise Buster AI supports batch processing that lets you automatically process a series of images and saves you
time and effort. It is useful when dealing with a lot of photos taken under the same conditions with identical camera settings.

 

 

Even if you've never used this feature before it is simple to learn!

If you use the standalone version of AKVIS Noise Buster AI, read the instructions here.

If you use the Noise Buster AI plugin in Photoshop, use this tutorial.
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PROGRAM PREFERENCES

The button  opens the Preferences dialog box. It looks like this:

Language. Change the program language by selecting another from the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will
automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light or Dark.
Initial Image Scale. This parameter defines the way the image is scaled in the Image Window after opening. The
parameter can take one of two values:

- image scaling Fit to View. The scale adjusts so that the image will be completely visible in the Image Window;
- if the option 100% is checked, image doesn't scale. Generally, when the scale = 100%, only part of the image
will be visible.

Recent Files (only in the standalone version). The number of recent documents. The list of the recent files, sorted by

time, become visible by right clicking . Maximum: 30 files.

Preview Window Size. Choose the desired value of the size of the quick preview area. It can have values from
200х200 to 1000х1000 pixels.
Hints. When you hover over parameters and buttons with the cursor you can see a brief description of them in the
Hints field. You can choose how the hints will be shown:

- Under Settings Panel. Select this to show hints at the bottom of the right part, under the settings;
- Under Image Window. It shows the hints in the main window, under the image. This mode is useful if there is
not enough space by height to display this field under the settings;
- Hide. Use this option if you do not need the hints.

Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the check-box is selected,
the panel is always visible.
Old Algorithm. When the check-box is turned on, the traditional noise reduction algorithm (non-AI) from previous
versions of the program will be applied.

To save changes made in the Preferences window press OK.

If you need, click the Default button to come back to the default settings.

 

AKVIS Noise Buster AI

31



TRADITIONAL NOISE REDUCTION ALGORITHM

AKVIS Noise Buster AI allows you to remove both luminance and color noise from your digital photographs. Before version
12.0, the software used the traditional noise reduction algorithm. Since version 12.0, the program uses trained neural
networks. You can switch to the old algorithm by selecting the corresponding option in the Preferences.

Noise Removal

Noise on any color picture can be divided into luminance noise and color noise. Luminance noise is perceived as dark dots
or small blots, color noise represents color spots on areas having a different color. Another name for color noise is chroma
noise.

The Histogram below the Settings is a graphical depiction of the noise level and noise components of the original picture.
The gray area shows the luminance noise; the red area shows the color noise. The more the histogram is shifted to the
right, the higher the noise level is. And vice versa, if the histogram is shifted to the left, the image has a low noise level. The
height of the histogram displays the number of pixels having this noise level.

When adjusting the parameters, pay attention to the right part of the histogram, as it shows the amount of highly noised
pixels. The amount of pixels in the left part shows low noised pixels that are a part of the picture, its natural background.

Image Noise Histogram

Note: On a grayscale photo there is no color component and therefore no color noise. To suppress noise on a grayscale
photo it is enough to regulate the parameters of the Luminance Noise.

Attention! The Histogram is only a graphic representation of the picture’s noise level. It does not change as you
change the settings. The histogram helps you estimate the noise level and decide what parameters should be adjusted.

 

On the Settings Panel, adjust the effect parameters:

Fade (0-100%). This parameter sets the mixing ratio of the filtered image and the original. At 100% all elements of the photo
defined as noise are smoothed in accordance with the value of the parameter Smooth Level. As you move the slider to the
left (i.e. reduce the value of the parameter), the original image noise mixes into the filtered image; at 0% there is no filtration
at all. In most cases a certain amount of original noise adds to the natural look of an image and allows restoring small details.
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Fade = 10%

 
Fade = 90%

 
Quality = 3

 
Quality = 10

 
Noise Level = 0

 
Noise Level = 100

 
Smooth Level = 20

 
Smooth Level = 100

Quality (1-20). The parameter reduces the number of color spots but significantly increases the processing time.

Noise Level (0-100). The parameter defines which elements of the image are to be considered noise (luminance or color) and
which are to be considered important details. At high value of the parameter small details can be defined as noise and,
therefore, be smoothed.

Smooth Level (0-100). The parameter sets the extent to which the elements defined as noise should be smoothed. The
higher the parameter, the smoother the filtration result. However, at high values of the parameter, an image can lose detail
and look flat. High values of the parameter Smooth Level for color noise can produce an alteration of colors and loss of small
color details.
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Microdetail = 10

 

Microdetail = 80

 

Edge Intensity = 0

 

Edge Intensity = 100

 

Sharpness = 0

 

Sharpness = 100

Improve Detail Parameter Group:

Microdetail (0-100). The parameter restores small details on the image. The default value usually offers a satisfactory
result, but it is possible to increase the value of the parameter to improve sharpness.

Edge Intensity (0-100). The parameter makes the edges and borders more visible without revealing noise. The higher
the value, the stronger the effect - the edges become clear and well-defined.

Sharpness (0-100). The parameter changes the contrast of adjacent pixels. Use this parameter carefully, it can return
digital noise to the image.

Remove Moiré Check-Box. Use this mode to reduce unwanted moiré patterns and remove halftone from scanned newspaper
photos. The degree of smoothing is regulated by the Blur parameter.

Note: The Remove Moiré check-box and the Blur parameter are available only for Home Deluxe and Business licenses.
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Blur = 1.0

 
Blur = 4.0

Halftone Image
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PRINT IMAGES IN AKVIS NOISE BUSTER AI

In the standalone version of AKVIS Noise Buster AI you can print the image. Press the button  to open the Print

options.

Print Options in AKVIS Noise Buster AI

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the
print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These
parameters have no effect on the image itself, just on the print version. You can change the size of the printed image
by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the
image on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a
large picture.

Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the
program will automatically select the optimal number of the pages in accordance with the actual size of the image
(scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins
will be added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be
printed in the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.
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COLOR NOISE SUPPRESSION

Shooting with a good camera does not necessarily spare you from trouble with noise. If lighting is insufficient for the sensor,
you can often see color noise in your photos. Color (chroma) noise is perceived as random color dots spoiling the color
accuracy of a shot.

Below is a fragment of the image: before and after the color noise suppression in AKVIS Noise Buster AI.

 

The following photo illustrates color noise.

If we scale up the image, we will see color noise. Do you see these color blots on the cat's hair?

Step 1. Open the photo in AKVIS Noise Buster AI.

Try the default parameters. The result will be shown in the preview area in the Before tab. To evaluate the accuracy of
noise reduction, you can drag the preview frame to see any other part of the photo processed, or just draw the preview
area anew on any part of the image.
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Step 2. The color noise is completely suppressed with the default settings!

To apply the noise reduction settings to the entire image, click .
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REDUCE NOISE ON A STUDIO PHOTO

Digital noise can appear even on professional photos made with high-quality cameras, for example, if you use high ISO
settings. AKVIS Noise Buster AI suppresses both luminance and color noise on digital images.

 

The following photo has been taken with the NIKON E5700 digital camera at ISO 400.

On the reduced copy noise is not visible, but if we scale up the photo to 100% or more it will become manifest: we can see
luminance noise on the red background and color noise (red and violet blots) on the pet's hair.

 

Most likely the noise was caused by high sensitivity settings for the camera sensor.

To reduce noise in the photo, we use AKVIS Noise Buster AI (standalone app).

Step 1. Open the image in AKVIS Noise Buster AI using the  button.

The result will be displayed in the quick preview area.
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Step 2. To enhance this photo, we use the settings displayed in the image below:

Step 3. The result will be shown in the preview area. To apply the noise reduction settings to the entire image, press 

.

If you are happy with the result, click  to save the image.

Below is an image fragment: on the left - before, on the right - after the processing with the above-mentioned settings.
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Original Image Result

PROFESSIONAL PORTRAIT: COVER GIRL

AKVIS Noise Buster AI can be helpful not only for the "noisy" images enhancement but for improving the quality of shots as
well. You can apply it to portraits to smooth the skin of a model.

In professional portrait photography, they often use special softening filters that smooth small wrinkles and mask minor skin
defects.

Click the images to open larger variants

 

At first glance, the photo seems pretty good. However, if we increase the scale of the image we can see the unevenness of
the skin that spoils the impression from the shot.

AKVIS Noise Buster AI will help us to smooth the skin and create a "cover-girl" effect.

The software is available as a standalone program or a plug-in. We will use the standalone version.

 

Step 1. First, open the image in AKVIS Noise Buster AI with the  button.

The program processes the image using the default settings. The result is shown in the quick preview area in the
Before tab.
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Step 2. After processing with the default settings, the girl’s eyes look “foggy”, and her hair becomes blurry. Adjust the
parameters to minimize blurring.

Step 3. We are satisfied with the result of filtering in the preview area and apply it to the whole image with the 

button.
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Hint: If necessary, you can restore some details (eyes, hair) using the History Brush . Adjust the strength of the

effect of the tool and process the areas.

Step 4. Finally, press  to save the image.

Pay attention to the girl's skin, now it is smooth and even!

This photo could be published in a fashion magazine.
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Original Image Result

REMOVE MOIRE ON SCANS

Images in print media represent a series of overlapping dots that should create an illusion of more colors. When you scan such
a photo you can usually discover a moire pattern. A moire pattern results from incorrect screen angles of overprinting
halftones.

You can try to avoid moire at the scanning stage. Sometimes a well-chosen scan angle can produce a remarkable effect.
However, if you deal with a scanned image you have only one method of moire suppression at your disposal - apply image
processing techniques.

On the photo below you can see a scan of a music CD cover. Moire is visible.

Step 1. Open this fragment of the scanned cover in AKVIS Noise Buster AI with the  button.

Noise Buster AI will process the image using the default settings.
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Step 2. If necessary, change the noise removal mode and adjust the post-processing parameters. In this example, we
used the following values:

Step 3. If the result in the preview area is good, press the  button to apply the filtering to the whole image. Then

save the image by pressing the  button.
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool
that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using
chosen settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the
quality of compressed images. This program provides 4 image enhancement modes, each involves a unique neural network
developed especially for this occasion. The software is available free of charge for home users. For commercial use, a Business
license is offered. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and
texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different artistic techniques: Oil Painting, Watercolor,
Gouache, Comics, Pen & Ink, Linocut, Stencil, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any
picture! More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is
very easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…
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AKVIS Charcoal — Turn Photos into Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can
make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding
artistic effects such as sanguine, sepia, and others. More…

 

AKVIS Coloriage AI — Add Color to Black and White Photos

AKVIS Coloriage AI allows colorizing B&W photos. The program includes an AI-powered image colorization mode based on
machine learning, as well as the classic method of manual coloring using zone selection. Breathe new life into your old family
photographs! More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things
differently. Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a
photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve Detail,
Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to a
picture, it lets you improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies
dust and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The program
can also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS Inspire AI — Artistic Stylization of Images

AKVIS Inspire AI stylizes images using various samples of painting. The AI-based program applies the color scheme and style
of a selected artwork to a photo creating a new masterpiece. The software includes a gallery of art styles and allows to load
a custom sample. Imitate the style of world famous artists! More…

AKVIS Noise Buster AI

53

https://akvis.com/en/explosion/index.php?utm_source=help
https://akvis.com/en/frames/index.php?utm_source=help
https://akvis.com/en/frame-packs/index.php?utm_source=help
https://akvis.com/en/frames/index.php?utm_source=help
https://akvis.com/en/hdrfactory/index.php?utm_source=help
https://akvis.com/en/hdrfactory/index.php?utm_source=help
https://akvis.com/en/hdrfactory/index.php?utm_source=help
https://akvis.com/en/inspire/index.php?utm_source=help
https://akvis.com/en/inspire/index.php?utm_source=help


 

AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting
techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little
magic to your pictures! More…

 

AKVIS Magnifier AI — Enlarge Images & Enhance Quality

AKVIS Magnifier AI allows you to increase the size of photos and improve image quality and appearance. Featuring neural
network-based algorithms, Magnifier AI upscales images to super-high resolution, up to 800%, and produces wall-sized prints.
Improve image resolution, create clear, detailed images with perfect quality! More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making
your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look
your best in every photo with AKVIS MakeUp! More…
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AKVIS NatureArt — Bring Nature to Your Photos

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program
includes a number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like
drawn with luminescent ink. More…
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AKVIS Noise Buster AI — Digital Noise Reduction

AKVIS Noise Buster AI is software for noise suppression on digital and scanned images. The program is efficient for removing
any type of digital noise. It reduces both luminance and color noise without spoiling other aspects of photos. The software
includes AI technologies and adjustments for manual refining. More…

 

AKVIS OilPaint — Oil Painting Effect for Your Photos

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes.
The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can
become a painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one
of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…
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AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism.
With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors!
More…

 

AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating
a selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five
image processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches,
stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using
the information of the surrounding areas. More…
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AKVIS Sketch — Turn Your Photos into Pencil Sketches

AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W
sketches, imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles:
Classic, Artistic, Maestro, and Multistyle, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist!
More…

 

AKVIS SmartMask AI — Selection Made Easy

AKVIS SmartMask AI is an efficient selection tool that saves time and is fun to use. Equipped with artificial intelligence tools,
the program is the most convenient and fastest way to mask objects in an image. The software considerably increases your
productivity. You will be freed from boring work and will have more room for creativity and realization of your ideas. More…

 

AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The program includes two styles
of photo to painting conversion: Classic Watercolor and Contour Watercolor; each comes with a wide range of ready-to-use
presets. The software turns ordinary images into aquarelle pieces of art. More…
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